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Congratulations on your purchase of the Dayton Audi o DATS V2 Test System. DATS V2 is the second genera tion of the 
popular DATS loudspeaker test system, but its versa tility extends beyond loudspeakers to testing many other types of 

audio devices, operating as a test signal generator  and oscilloscope for small signal audio-spectrum a pplications. 
 

Here are step-by-step instructions to get you start ed making driver measurements quickly and easily us ing DATS V2. 
Later, as you wish to learn more about using the ot her features of DATS V2, you can refer to the built -in User’s Guide 
found under the Help menu. 

 
Skip directly to the section that covers your versi on of Windows (7, 8, Vista or XP). 
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I. Quick Start for DATS V2 on Windows 8  

 
 
DATS V2 is compatible with Windows 8 and Windows 8. 1, using the setup procedure given below. (For use with 
Windows 7 or earlier, skip to the section of this Q uick Start guide that corresponds to your operating  system, since 
these versions of Windows require a different proce dure.)  
 
1) Install the DATS V2 software.  

Right-click on the Windows icon at the bottom left of the Windows 8 desktop. Open the File Explorer, 
then navigate to This PC (if not already there). In the right-hand pane of the window, double-click on the 
DATS V2 CD icon. In the User Account Control message that appears, click “Yes”. Accept the default 
installation path or click “Browse” to choose a different one. Last, click “Install” to proceed with 
installation, and then click on “Close” after the installation completes. 

Check for available upgrades at: http://www.trueaudio.com/DATS 

2) Connect the DATS V2 hardware unit to any conveni ent USB port on your computer.  
Upon being connected and powering up the DATS V2 unit requires about 10 seconds to stabi lize 
before measurements can be made . After this plug-in delay, impedance measurements take only a few 
seconds to complete. Any USB port can be used with DATS but each port remembers its setup, so the 
same USB port should be used for measurements in the future.  The audio setup in the following steps will 
need to be performed again if the device is plugged into a different USB port.  
 
 
 



 
 

3) Setup the USB port for 2-channel input and verif y the input level for Windows 8.  
Right-click on the Windows icon at the bottom left of the Windows 8 desktop. Open the Control Panel, then 
select “Hardware and Sound”. Click on “Manage Audio Devices”. The Sound control panel will appear. In 
the “Playback” tab, make sure the “USB Audio CODEC” device is set to be the default playback device, 
then click on “Properties”. In the levels tab, set the level slider to 100. In the Advanced tab, make sure that 
“16 Bit, 44100 Hz (CD Quality)” is selected as the default format, then click OK. 
 

    
 
 

In the “Recording” tab of the Sound control panel, make sure the “USB Audio CODEC” is set to be the 
default recording device, then click on “Properties”. In the Levels tab, set the level to 54 (Note:  this is the 
default value that Windows will set for the device; a larger value can cause clipping distortion to pollute the 
measurement). In the Advanced tab, make sure that “2 channel, 16 bit, 44100 Hz (CD Quality)” is selected 
as the default format. Then click OK to close the Properties window, and click OK to close the Sound 
control panel. Windows will store these settings. 
 

    
 



 

4) Raise the Windows volume control to maximum.  
From the task bar, raise the Windows volume control to maximum for the best possible measurement. 
 

5) Launch the DATS V2 application software.  
From the Windows 8 “Start” screen, select the down arrow to show all apps, then select “DATS V2”. The 
DATS V2 software will launch. 

6) Calibrate the test leads.  
From the DATS “Impedance Analyzer” menu select “Test Leads Calibration…”. Short the test leads by 
clipping them together and click OK to calibrate the software for the test lead resistance. The test lead 
resistance should be less than 1 Ohm as seen at the bottom right of the DATS screen. If not, wait a few 
seconds and try again…the hardware needs a full 10 seconds to stabilize after power up. If the test leads 
should fail to calibrate then select “Impedance Calibration…” under the Impedance Analyzer menu, click 
on “Restore Default Calibration” and repeat the test leads calibration procedure. 

7) Calibrate at 1k Ohms.  
Select “Impedance Calibration” under the “Impedance Analyzer” menu and follow the instructions to 
calibrate the system at 1k Ohms using the supplied precision 1% resistor. The software will test the resistor 
and plot the results. The calibrated impedance is displayed and the calibration is complete. Verify that the 
value displayed in the R(e) field at the right side of the screen is reasonably close to 1000 Ohms. If not, 
repeat the calibration procedure making sure the hardware has had a full 10 seconds to stabilize. A 
measured value between 950 and 1050 Ohms is expected. 

8) Connect the DATS alligator clips to the terminal s of the speaker to be tested.  
The speaker MUST NOT BE CONNECTED to anything else such as an amplifier, other electrical 
equipment or an electrical ground. For best results clamp the driver in place and allow adequate clearance 
for any rear pole piece vents. 
 

9) Click on the "Measure Free Air Parameters" butto n at the left of the DATS window.  
You should hear the sweep and then see the impedance response of the driver appear on the screen 
similar to the screen below. The speaker’s free air parameters are displayed in the Parameters Bar at the 
right side of the screen. At the left side you can set the upper impedance limit and the high and low 
frequency limits. 

 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10) Measure the driver’s V(as). 
Once you have measured the speaker’s free air parameters the "Measure V(as)" button becomes enabled. 
Select one of the three methods to measure the V(as) at the upper right side of the DATS V2 screen. The 
three V(as) measurement methods are: 

 
Test Box Method  - requires a suitable test box 
Added Mass Method  - requires you to add a known ma ss 
Specified SPL Method  - requires the SPL be known 
Specified M(MD) Method  - requires the M(MD) be kno wn 

 
Enter the required data and then press the “Measure V(as)” button to start the measurement procedure. 

 

11) After measuring the speaker you can: 
·  Save the data to one of 20 project memories. 
·  Save a DATS project file (file type .DATS) which includes your test setup and all 20 memories. 
·  Export the parameters and impedance data in either .txt or .zma formats. 
·  Overlay plots of various measured impedances from the 20 memories for detailed comparison. 
·  Print a report showing the impedance and parameters of the displayed memories. 

 

12) Quit DATS V2. 
Quit the DATS V2 application software by using “Ctrl+Q” from the keyboard or by selecting “Exit” under the 
“File” menu. On exit the software saves your application settings for the next session.  

 

13) Future sessions with DATS V2. 
In the future when you want to use DATS V2 you only need to connect the DATS V2 hardware unit, raise 
the master volume and then launch the DATS V2 software. If you happen to launch the software first you 
will then need to select “Audio Device Selection…” under the “Edit” menu so that DATS V2 can scan for the 
hardware and select it for use. The software will retain its calibration from session to session but it is still a 
good idea to verify the calibration at the start of each session by sweeping the supplied calibration resistor 
or some other resistor of known value. 
 
 
 
 
 
 
 
 
 
 



 
Note: Skip directly to the section that covers your  version of Windows. 

 

II. Quick Start for DATS V2 on Windows 7  

 

 

1) Install the DATS V2 software. 
Insert the DATS V2 CD into your PC’s drive and allow the file named "DATS V2_setup.exe" to auto-play. 
(Alternately you can double-click on the file "DATS V2_setup.exe" to start the installation process.) 
Follow the on-screen instructions to complete the software installation. Do not launch the software yet.  
 
Check for available upgrades at: http://www.trueaudio.com/DATS V2 

 

2) Connect the DATS V2 hardware unit to any conveni ent USB port on your computer.  
Upon being connected and powering up the unit requires about 10 seconds to stabilize bef ore 
measurements can be made . After this plug-in delay, impedance measurements take only a few seconds 
to complete. Any USB port can be used with DATS V2 but each port remembers its setup. For this reason 
you can either use DATS V2 with one particular USB port or you can setup each of your USB ports in turn 
to use DATS V2. It is not a bad idea to just plug the unit into each port in sequence and set each port for 2-
channel input as required for DATS V2.  
 

3) Setup the USB port for 2-channel input and verif y the input level for Windows 7.  
From the Windows “Start” button select Control Panel/Sound. Once the Sound control panel opens select 
the “Recording” tab as seen below (left). Next, double-click on the device “USB Audio Device” to open the 
Properties window seen below (right). Note that on Windows 7 the DATS V2 hardware may appear as 
"USB Audio CODEC",  "USB Audio Device" or similar. 
 

    
 

 
 

 

Switch to the “Advanced” tab and select “2 channel, 16 bit, 44100 Hz (CD Quality) ” as seen below (left). 
Next, select the “Levels” tab set the level is set to exactly “1” as seen below (right). These two steps are 
critical  as DATS V2 will not operate with the default audio settings of maximum level and 1 channel input. 
 



        
 

Click the “OK” button once to close the Properties window and then click “OK” again to close the Sound 
Control Panel. Disconnect the DATS V2 USB unit from the first USB port and repeat this setup sequence 
for each USB port on your PC that you wish to be setup for use with DATS V2. You should only need to do 
this one time as each USB port remembers its own settings separately from the other ports. 
 

4) Raise the Windows volume control to maximum. 
From the task bar, raise the Windows volume control to maximum. 

 

5) Launch the DATS V2 application software. 
From the Windows “Start” button select “All Programs” then select “DATS V2”. The DATS V2 software will 
launch. 

 

6) Calibrate the test leads. 
From the DATS V2 “Impedance Analyzer” menu select “Test Leads Calibration…”. Short the test leads by 
clipping them together and click OK to calibrate the software for the test lead resistance. The test lead 
resistance should be less than 1 Ohm as seen at the bottom right of the DATS V2 screen. If not, wait a few 
seconds and try again…the hardware needs a full 10 seconds to stabilize after power up. If the test leads 
should fail to calibrate then select “Impedance Calibration…” under the Impedance Analyzer menu, click on 
“Restore Default Calibration” and repeat the test leads calibration procedure. 

 

7) Calibrate at 1k Ohms. 
Select “Impedance Calibration” under the “Impedance Analyzer” menu and follow the instructions to 
calibrate the system at 1k Ohms using the supplied precision 1% resistor. The software will test the resistor 
and plot the results. The calibrated impedance is displayed and the calibration is complete. Verify that the 
value displayed in the R(e) field at the right side of the screen is reasonably close to 1000 Ohms. If not, 
repeat the calibration procedure making sure the hardware has had a full 10 seconds to stabilize. A 
measured value between 950 and 1050 Ohms is expected. 

 

8) Connect the DATS V2 alligator clips to the termi nals of the speaker to be tested.  
The speaker MUST NOT BE CONNECTED to anything else such as an amplifier, other electrical 
equipment or ground. For best results clamp the driver in place and allow adequate clearance for any rear 
pole piece vents. 

 



9) Click on the "Measure Free Air Parameters" butto n at the left of the DATS V2 window.  

You should hear the sweep and then see the impedance response of the driver appear on the screen 
similar to the screen below. The speaker’s free air parameters are displayed in the Parameters Bar at the 
right side of the screen. At the left side you can set the upper impedance limit and the high and low 
frequency limits. 
 

 
 

10) Measure the driver’s V(as). 
Once you have measured the speaker’s free air parameters the "Measure V(as)" button becomes enabled. 
Select one of the three methods to measure the V(as) at the upper right side of the DATS V2 screen. The 
three V(as) measurement methods are: 

 
Test Box Method  - requires a suitable test box 
Added Mass Method  - requires you to add a known ma ss 
Specified SPL Method  - requires the SPL be known 
Specified M(MD) Method  - requires the M(MD) be kno wn 

 
Enter the required data and then press the “Measure V(as)” button to start the measurement procedure. 

 

11) After measuring the speaker you can: 
·  Save the data to one of 20 project memories. 
·  Save a DATS project file (file type .DATS) which includes your test setup and all 20 memories. 
·  Export the parameters and impedance data in either .txt or .zma formats. 
·  Overlay plots of various measured impedances from the 20 memories for detailed comparison. 
·  Print a report showing the impedance and parameters of the displayed memories. 

 

12) Quit DATS V2. 
Quit the DATS V2 application software by using “Ctrl+Q” from the keyboard or by selecting “Exit” under the 
“File” menu. On exit the software saves your application settings for the next session.  

 

13) Future sessions with DATS V2. 
In the future when you want to use DATS V2 you only need to connect the DATS V2 hardware unit, raise 
the master volume and then launch the DATS V2 software. If you happen to launch the software first you 
will then need to select “Audio Device Selection…” under the “Edit” menu so that DATS V2 can scan for the 
hardware and select it for use. The software will retain its calibration from session to session but it is still a 
good idea to verify the calibration at the start of each session by sweeping the supplied calibration resistor 
or some other resistor of known value. 

 
 
 
 
 
 
 
 
 
 

 



Note: Skip directly to the section that covers your  version of Windows. 

 
III. Quick Start for DATS V2 on Windows Vista  

 

 

1) Install the DATS V2 Software. 
Insert the DATS V2 CD into your PC’s drive and allow the file named "DATS V2_setup.exe" to auto-play. 
(Alternately you can double-click on the file "DATS V2_setup.exe" to start the installation process.) 
Follow the on-screen instructions to complete the software installation. Do not launch the software yet.  
 
Check for available upgrades at: http://www.trueaudio.com/DATS V2 

 

2) Connect the DATS V2 hardware unit to any conveni ent USB port on your computer.  
Upon being connected and powering up the unit requires about 10 seconds to stabilize bef ore 
measurements can be made . After this plug-in delay, impedance measurements take only a few seconds 
to complete. Any USB port can be used with DATS V2 but each port remembers its setup. For this reason 
you can either use DATS V2 with one particular USB port or you can setup each of your USB ports in turn 
to use DATS V2. It is not a bad idea to just plug the unit into each port in sequence and set each port for 2-
channel input as required for DATS V2.  
 

3) Setup the USB port for 2-channel input and verif y the input level for Windows Vista.  
From the Windows “Start” button select Control Panel/Sound. Once the Sound control panel opens select 
the “Recording” tab as seen below (left). Next, double-click on the device “USB Audio CODEC” to open the 
Properties window seen below (right). 
 

     
 

 
 
 

 

Switch to the “Advanced” tab and select “2 channel, 16 bit, 44100 Hz (CD Quality) ” as seen below (left). 
This step is critical  as DATS V2 will not operate with the default audio setting of 1 channel input. Next, 
select the “Levels” tab and verify that the level is set to “25” as seen below (right). 
 



    
 
Click the “OK” button once to close the Properties window and then click “OK” again to close the Sound 
Control Panel. Disconnect the DATS V2 USB unit from the first USB port and repeat this setup sequence 
for each USB port on your PC that you wish to be setup for use with DATS V2. You should only need to do 
this one time as each USB port remembers its own settings separately from the other ports. 

 

4) Raise the Windows volume control to maximum. 
From the task bar, raise the Windows volume control to maximum. 

 

5) Launch the DATS V2 application software. 
From the Windows “Start” button select “All Programs” then select “DATS V2”. The DATS V2 software will 
launch. 

 

6) Calibrate the test leads. 
From the DATS V2 “Impedance Analyzer” menu select “Test Leads Calibration…”. Short the test leads by 
clipping them together and click OK to calibrate the software for the test lead resistance. The test lead 
resistance should be less than 1 Ohm as seen at the bottom right of the DATS V2 screen. If not, wait a few 
seconds and try again…the hardware needs a full 10 seconds to stabilize after power up. If the test leads 
should fail to calibrate then select “Impedance Calibration…” under the Impedance Analyzer menu, click on 
“Restore Default Calibration” and repeat the test leads calibration procedure. 

 

7) Calibrate at 1k Ohms. 
Select “Impedance Calibration” under the “Impedance Analyzer” menu and follow the instructions to 
calibrate the system at 1k Ohms using the supplied precision 1% resistor. The software will test the resistor 
and plot the results. The calibrated impedance is displayed and the calibration is complete. Verify that the 
value displayed in the R(e) field at the right side of the screen is reasonably close to 1000 Ohms. If not, 
repeat the calibration procedure making sure the hardware has had a full 10 seconds to stabilize. A 
measured value between 950 and 1050 Ohms is expected. 

 

8) Connect the DATS V2 alligator clips to the termi nals of the speaker to be tested.  
The speaker MUST NOT BE CONNECTED to anything else such as an amplifier, other electrical 
equipment or ground. For best results clamp the driver in place and allow adequate clearance for any rear 
pole piece vents. 

 

9) Click on the "Measure Free Air Parameters" butto n at the left of the DATS V2 window.  

You should hear the sweep and then see the impedance response of the driver appear on the screen 
similar to the screen below. The speaker’s free air parameters are displayed in the Parameters Bar at the 
right side of the screen. At the left side you can set the upper impedance limit and the high and low 
frequency limits. 
 



 
 

10) Measure the driver’s V(as). 
Once you have measured the speaker’s free air parameters the "Measure V(as)" button becomes enabled. 
Select one of the three methods to measure the V(as) at the upper right side of the DATS V2 screen. The 
three V(as) measurement methods are: 

 
Test Box Method  - requires a suitable test box 
Added Mass Method  - requires you to add a known ma ss 
Specified SPL Method  - requires the SPL be known 
Specified M(MD) Method  - requires the M(MD) be kno wn 

 
Enter the required data and then press the “Measure V(as)” button to start the measurement procedure. 

 

11) After measuring the speaker you can:  

·  Save the data to one of 20 project memories. 
·  Save a DATS project file (file type .DATS) which includes your test setup and all 20 memories. 
·  Export the parameters and impedance data in either .txt or .zma formats. 
·  Overlay plots of various measured impedances from the 20 memories for detailed comparison. 
·  Print a report showing the impedance and parameters of the displayed memories. 

 

12) Quit DATS V2. 
Quit the DATS V2 application software by using “Ctrl+Q” from the keyboard or by selecting “Exit” under the 
“File” menu. On exit the software saves your application settings for the next session.  

 

13) Future sessions with DATS V2. 
In the future when you want to use DATS V2 you only need to connect the DATS V2 hardware unit, raise 
the master volume and then launch the DATS V2 software. If you happen to launch the software first you 
will then need to select “Audio Device Selection…” under the “Edit” menu so that DATS V2 can scan for the 
hardware and select it for use. The software will retain its calibration from session to session but it is still a 
good idea to verify the calibration at the start of each session by sweeping the supplied calibration resistor 
or some other resistor of known value. 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

IV. Quick Start for DATS V2 on Windows XP  
 
 

1) Install the DATS V2 software. 
Insert the DATS V2 CD into your PC’s drive and allow the file named "DATS V2_setup.exe" to auto-play. 
(Alternately you can double-click on the file "DATS V2_setup.exe" to start the installation process.) 
Follow the on-screen instructions to complete the software installation. Do not launch the software.  
 
Check for available upgrades at: http://www.trueaudio.com/DATS V2 

 

2) Connect the DATS V2 hardware unit to any conveni ent USB port on your computer.  
Upon being connected and powering up the unit requires a full 10 seconds to stabilize be fore 
measurements can be made . After this plug-in delay, impedance measurements take only a few seconds 
to complete. 
 

3) Audio Configuration 
Open the Windows Sound Control Panel and select the Audio tab. Then select the Default device to be the 
“USB Audio CODEC” (this is the DATS V2 hardware) as shown below at the left. Click on “Volume…” to 
open the mixer shown below at the right. Make sure the “Speaker” and “Wave” volumes are set to 
maximum and that the corresponding balance controls are set to center. Once the Volumes are set 
correctly, the Default device does not have to remain set to the “USB Audio CODEC” and can be set to 
another device if necessary. 
 

   
 

4) Launch the DATS V2 application software. 
From the Windows “Start” button select “All Programs” then select “DATS V2”. 

 

5) Calibrate the test leads. 
From the DATS V2 “Impedance Analyzer” menu select “Test Leads Calibration…”. Short the test leads by 
clipping them together and click OK to calibrate the software for the test lead resistance. The test lead 
resistance should be less than 1 Ohm as seen at the bottom right of the DATS V2 screen. If not, wait a few 
seconds and try again…the hardware needs a full 90 seconds to stabilize after power up. If the test leads 
should fail to calibrate then select “Impedance Calibration…” under the Impedance Analyzer menu, click on 
“Restore Default Calibration” and repeat the test leads calibration procedure. 

 

6) Calibrate at 1k Ohms. 
Select “Impedance Calibration” under the “Impedance Analyzer” menu and follow the instructions to 
calibrate the system at 1k Ohms using the supplied precision 1% resistor. The software will test the resistor 
and plot the results. The calibrated impedance is displayed and the calibration is complete. Verify that the 
value displayed in the R(e) field at the lower right side of the DATS V2 screen is reasonably close to 1000 



Ohms. If not, repeat the calibration procedure making sure the hardware has had a full 90 seconds to 
stabilize. A measured value between 950 and 1050 Ohms is expected. 

 

7) Connect the DATS V2 alligator clips to the termi nals of the speaker to be tested.  
The speaker MUST NOT BE CONNECTED to anything else such as an amplifier, other electrical 
equipment or ground. For best results clamp the driver in place and allow adequate clearance for any rear 
pole piece vents. 

 

8) Click on the "Measure Free Air Parameters" butto n at the left of the DATS V2 window. 
You should hear the sweep and then see the impedance response of the driver appear on the screen. The 
speaker’s free air parameters are displayed in the Parameters Bar at the right side of the screen. At the left 
side you can set the upper impedance limit and the high and low frequency limits. 

 

 
 
 
 

9) Measure the driver’s V(as). 
Once you have measured the speaker’s free air parameters the "Measure V(as)" button becomes enabled. 
Select one of the three methods to measure the V(as) at the upper right side of the DATS V2 screen. The 
three V(as) measurement methods are: 
 

Test Box Method  - requires a suitable test box 
Added Mass Method  - requires you to add a known ma ss 
Specified SPL Method  - requires the SPL be known 
Specified M(MD) Method  - requires the M(MD) be kno wn 
 

Enter the required data and press the “Measure V(as)” button to start the measurement procedure 
 
 

10) After measuring the speaker you can: 
·  Save the data to one of 20 project memories. 
·  Save a DATS project file (file type .DATS) which includes your test setup and all 20 memories. 
·  Export the parameters and impedance data in either .txt or .zma formats. 
·  Overlay plots of various measured impedances from the 20 memories for detailed comparison. 
·  Print a report showing the impedance and parameters of the displayed memories. 

 

11) Quit DATS V2. 
Quit the DATS V2 application software by using “Ctrl+Q” from the keyboard or by selecting “Exit” under the 
“File” menu. On exit the software saves your application settings for the next session.  

 

12) Future sessions with DATS V2. 
In the future when you want to use DATS V2 you only need to connect the DATS V2 hardware unit and 
then launch the DATS V2 software. If you happen to launch the software first you will need to first select 
“Audio Device Selection…” under the “Edit” menu so that DATS V2 can scan for the hardware and select it 
for use. The software will retain its calibration from session to session but it is still a good idea to verify the 
calibration at the start of each session by sweeping the supplied calibration resistor or some other resistor 
of known value. 



V. Troubleshooting Guide for DATS V2  
(All Operating Systems) 

 
 

WARNING - VERY IMPORTANT 
 

NEVER connect the test leads of the DATS V2 device to a speaker that is connected to any 
other equipment, or to an equipment ground. Severe damage could occur to the sensitive 
DATS V2 unit or to the other equipment. Only connec t the DATS V2 device to an isolated 
(unconnected) loudspeaker. Failure to observe this warning may result in your DATS V2 

device requiring replacement. 
 

If the following common trouble situations are encountered, try the corresponding solutions: 
 

1. Problem: No sweep is heard, and graph shows wildly-“zigzag”-ing data. 
Cause:  No signal to the speaker under test, or the speaker does not pass signal. 
Solution:  

a. Verify a speaker is connected, and the voice coil does not read an open circuit using a DMM 
(blown or damaged speaker). 

b. Verify that the correct audio device is selected for playback, and that the volume control is 
set to maximum. 

c. Close and re-open the DATS V2 program, and re-try the test. 
 

2. Problem: A sweep is heard, but the graph shows wildly-“zigzag”-ing data. 
Cause: DATS not selected as recording device, or input volume is set to zero (below noise floor), 
or set too high (input distortion) 
Solution:  

a. Verify that the correct audio device is selected for recording. 
b. Verify that the recording level is set properly according to the Quick Start Guide for your 

operating system. 
c. Close and re-open the DATS V2 program, and re-try the test. 

 
3. Problem: A sweep is heard, but the graph shows two curved lines that intersect near the middle of 

the graph 
Cause:  DATS V2 audio device is set to only input one channel instead of two channels. 
Solution:  

a. Verify that the DATS V2 device is set for two channels of audio input, according to the 
Quick Start Guide for your operating system. (e.g. “2 channel, 16 bit, 44100 Hz (CD 
Quality)” option) 

b. Close and re-open the DATS V2 program, and re-try the test. 
 

4. Problem: A sweep is heard, and a curve is displayed, but the curve shows excessive ripple 
instead of a smooth contour. 
Cause: Input level from DATS V2 device set too low (noise infiltration) or set too high (onset of 
input distortion); rubbing or buzzing in speaker (defective speaker). 
Solution:  

a. Verify that the recording level is set to the recommended value according to the Quick 
Start Guide for your operating system. 

b. Try to locate another sample speaker to test and verify proper operation of the DATS V2 
test system. 

 
5. Problem: no sweep is heard, and the displayed graph is a flat line. 

Cause:  Short circuit between DATS V2 test leads (short circuit in speaker or other device under 
test), or DATS V2 test leads are shorted. 
Solution:  

a. Check the cabling of the test setup to ensure that no short circuits exist 
b. Locate another sample speaker to test and verify the original unit under test is not 

defective 
 
 



6. Problem: A sweep is heard, and the displayed graph is a flat line. 
Cause:  The device being measured is a resistor (or non-inductive load such as a planar tweeter), 
and will produce a flat graph (no reactance detected). 
Solution:  

a. Check the cabling of the test setup to ensure that no short circuits exist 
b. Verify that the type of device under test should have detectable reactance (e.g. not a 

resistor or a planar loudspeaker) 
c. Locate another sample speaker to test and verify the original unit under test is not 

defective. 
 

7. Problem:  DATS V2 device is not recognized by Windows (does not appear in Sound control 
panel), and/or blue light is not illuminated. 
Cause:  USB port may be inactive, or DATS V2 hardware device (“USB Audio CODEC”) may be 
disabled within Windows 
Solution:  

a. Verify that disabled audio devices are not “hidden” in the sound control panel by right-
clicking on the list. Deselect this option if enabled. (Windows Vista, 7, and 8 only) 

b. Verify that the hardware driver has been properly installed (normally this occurs 
automatically upon connecting the DATS V2 device) by checking in the Windows Device 
Manager for the “USB Audio CODEC” device. 

c. Verify that the “USB Audio CODEC” device is not disabled within the Windows Device 
Manager. 

d. Many PCs do not provide power to the USB port while off or in standby mode. Wake up 
the PC, then unplug and re-plug the DATS V2 device into the same USB port. 

e. Try plugging the DATS V2 device into another USB port on the same PC 
f. Try connecting the DATS V2 device to another PC. 
g. Try restarting the host PC. 

 
If these resolutions do not solve your particular problem, contact your place of purchase for technical support, 
or contact Dayton Audio. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Dayton Audio • 705 Pleasant Valley Dr. Springboro, OH 45066 • (937) 743�8248 • info@daytonaudio.com 
 
 
 
 
 

© 2014 John Murphy and Dayton Audio, All Rights Reserved Last Revised: 5/5/2014 


